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Introduction

This manual contains detailed instructions and notes on the operation and use of this product. For your

safety and benefit, read this manual carefully before using the product. Keep this manual in a handy

place for quick reference.

Trademarks

Microsoft, Windows, Windows Server, Windows Vista, Excel, and PowerPoint are either registered

trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Adobe, Acrobat, and Reader are registered trademarks of Adobe Systems Incorporated.

Outside In Viewer Technology Copyright (C) 1992-2003 Stellent Chicago, Inc. All rights reserved.

Jaws PDF Editor SDK. Copyright (C) 2005 Global Graphics Software Ltd. All Rights Reserved. 

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights to those marks.

The product names of the Windows operating systems are as follows:

• The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

• The product names of Windows Vista are as follows:

Microsoft® Windows Vista® Ultimate

Microsoft® Windows Vista® Enterprise

Microsoft® Windows Vista® Business

Microsoft® Windows Vista® Home Premium

Microsoft® Windows Vista® Home Basic

• The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

• The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition
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DeskTopBinder Manuals

Read the descriptions in each manual according to your purpose.

Note

❒ To display PDF form manuals, Adobe Acrobat or Adobe Reader must be in-
stalled on the client computer.

❖ Setup Guide
This manual explains setup methods and operating environment required to
use DeskTopBinder.
It also describes about settings necessary after DeskTopBinder installation
and how to deal with problems occurring during DeskTopBinder operation.

❖ Introduction Guide
This manual explains basic setting methods and operating procedures for
DeskTopBinder using graphics as dialog box or window examples.
It also describes about Function Palette and other tools installed at the same
time as DeskTopBinder.

❖ Auto Document Link Guide
This manual explains how to set delivery server in-trays, Windows folders,
Fax Received Files, and a Caplio digital camera as monitored items, and
transfer methods for documents or files found in the items.
It also describes about how to deal with problems occurring during Auto
Document Link operation.
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How to Read This Manual

Symbols

In this manual, the following symbols are used :

This symbol indicates a situation that may result in property damage or mal-
function if instructions are not followed. Be sure to read the instructions.

This symbol indicates information or preparations required prior to operating.

This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

This symbol indicates a reference.

[ ]

Elements on the machine's display panel or the computer's display, such as keys,
buttons, and menus.
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1. Overview of ScanRouter System

Overview of ScanRouter System

ScanRouter System is a group of document management applications that helps
users improve their business efficiency and productivity, and speed up manage-
ment and organizational procedures.

The volume of electronic and paper documents that must be stored increases on
a daily basis. ScanRouter System can efficiently manage huge amounts of docu-
ment data, such as scanned-in/fax-received image data and files made using
computer applications-creating a work environment that is optimized for busi-
ness usage information.

ScanRouter System documents can be easily retrieved, viewed, edited, printed,
and sent by e-mail to communicate information to any person at any time.

In addition to supporting a wide variety of user authentication methods, for ex-
tra security, ScanRouter System can protect users' documents using easily made
access settings.

ScanRouter System includes the following applications:

• DeskTopBinder Lite/Professional

• ScanRouter V2 Lite/Professional

• ScanRouter Enterprise

• ScanRouter EX Professional/Enterprise

• ScanRouter DocumentServer

• ScanRouter Web Navigator
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1. Network devices

You can input or output documents us-
ing network devices.

Documents scanned from a scanner or re-
ceived by fax are sent to the delivery
server.

If there is a hard disk drive (Document
Server) on a network device, the Docu-
ment Server receives documents read by
network device or received by fax. Docu-
ments in the Document Server can be
used with ScanRouter System software
products.

2. ScanRouter V2 Lite/Professional,
ScanRouter Enterprise, and Scan-
Router EX Professional/Enterprise
(delivery server)

The server works with other devices on
the network to deliver documents. Docu-
ments received from network devices are
delivered according to the delivery meth-
od configured for each destination.

Possible delivery methods include: sav-
ing in in-tray, sending by e-mail, and
adding to a document management serv-
er folder.

ADP001S

SCN

DOC
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3. ScanRouter DocumentServer
(document management server)

Documents created in different kinds of
application can be added from DeskTop-
Binder and ScanRouter Web Navigator to
the document management server. The
server arranges, sorts, and manages these
documents.

Configuring access rights for each cabi-
net and folder in the server restricts us-
er/group access and operations they can
perform, and prevents unwanted docu-
ment tampering.

4. ScanRouter Web Navigator (Web
server)

ScanRouter Web Navigator is a portal ap-
plication enabling access from Web client
to document management server and de-
livery server in-trays using a Web brows-
er.

It is not necessary to install ScanRouter
Web Navigator on each client computer,
since document operations can be per-
formed using the Web browser on client
computers.

5. Web Browser (client computer)

Client computers access the Web server
through the Web browser to search, dis-
play, and download documents in an in-
tray or in the document management
server.

6. DeskTopBinder Lite/Professional
(client computer)

On a client computer, DeskTopBinder
Lite/Professional manages various kinds
of data as documents.

Using DeskTopBinder Lite, documents in
the delivery server can be viewed and
managed. Using DeskTopBinder Profes-
sional, documents in the document man-
agement server and delivery server can
be viewed and managed.

When Document Server is used with a
network device, documents in Document
Server can be viewed from or copied to
DeskTopBinder Lite/Professional to be
edited or managed.
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DeskTopBinder

DeskTopBinder

DeskTopBinder can integrate various kinds of data, such as files made with dif-
ferent applications, scanned image data, and existing image files for total docu-
ment management.

When only DeskTopBinder is used, documents created on a computer can be
managed. However, by adding network locations from Extended Features, you
can view and manage documents in ScanRouter V2 Lite/Professional, Scan-
Router Enterprise, or ScanRouter EX Professional/Enterprise in-trays, or Scan-
Router DocumentServer cabinets using DeskTopBinder.

Furthermore, when DeskTopBinder is used with input/output devices, adding
scanned-in documents and outputting (Print and Send by Fax) documents from
DeskTopBinder are available. Depending on the network devices, saved docu-
ments in Document Servers can be copied to DeskTopBinder.

Documents in Document Servers can also be printed and outputted from Desk-
TopBinder.

Functional differences between DeskTopBinder Professional and DeskTopBinder Lite

Important

❒ There are two types of DeskTopBinder: DeskTopBinder Professional and
DeskTopBinder Lite. Both are described as DeskTopBinder in this Introduc-
tion Guide. Note that DeskTopBinder Professional has all the functions of
DeskTopBinder Lite plus some additional functions.

The following functions are not possible with DeskTopBinder Lite:

• Convert to PDF (displaying/setting PDF security information)

• Convert to Text (extract text from image using OCR)

• Using Viewer and Easy Viewer to display non-image files such as PDF files
and files created using an application

• Send by E-mail

• Import HTML

• Export HTML

• Export Document Properties Summary in CSV format

• Entry Assistant

• Print Document Properties Summary by List

• Specific Search

• Content Text Search for DeskTopBinder My Cabinet documents

• Create Content Text Search data
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• Connection to ScanRouter DocumentServer

• Creating shared cabinets

• Creating removable cabinets

• Using in a MetaFrame or Terminal Services environment

Limitation

❒ To display application data in the Thumbnails view of DeskTopBinder Lite,
the application used to create the data must be installed on the client comput-
er.

ScanRouter V2 Lite/Professional, ScanRouter Enterprise, and 
ScanRouter EX Professional/Enterprise

Incorporated with the ScanRouter delivery server, DeskTopBinder enables users
to view documents in in-trays and deliver them. The ScanRouter delivery server
must be configured using Extended Features in advance. ScanRouter has five
types: ScanRouter V2 Professional, ScanRouter V2 Lite, ScanRouter Enterprise,
ScanRouter EX Professional, and ScanRouter EX Enterprise.

ScanRouter DocumentServer

Incorporated with ScanRouter DocumentServer, DeskTopBinder enables users
to access and control documents in the server from client computers (DeskTop-
Binder). ScanRouter DocumentServer must be configured using Extended Fea-
tures in advance.

Each document can have specific document properties in addition to the file
name. These properties can be used to search for necessary documents.
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Document Management

Cabinets and Folders

Added documents are stored in a cabinet. In this cabinet, you can create folders
and use them to sort documents. 

This cabinet has a trash can where deleted files and documents are placed.

1. Document

2. Folder

3. Cabinet

Limitation

❒ When DeskTopBinder is installed, no more than one My Cabinet can be cre-
ated. However, shared cabinets and removable cabinets can be created as
needed.

Documents and Sections

You can add multiple files made with various applications as one document.
When saving multiple files as a document, one file becomes one section, and one
document is composed of multiple sections.

1. Section

2. Document

3. Data made with applications and
scanned image data

1

2

3
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Document Properties

Document properties are attribute information configured for each document.

With DeskTopBinder, document properties can be configured or checked on the
[Summary] and [Contents] tabs in the properties dialog box.

For properties of document management server or delivery server documents,
[Document Type] can separate documents according to document type and man-
age them.

Summary

Document properties summary, including information such as the creator, work
status, and expiration date, make document management easier.

Using DeskTopBinder, you can configure properties summary for each docu-
ment and check them using Properties. Items that can be checked are document
name, size, location, date added/modified/created, creator, work status, and
expiration date.

The document type determines the displayed items for document properties
summary of the document management server or delivery server documents.

Contents

A document is composed of multiple sections. On the [Contents] tab, information
about sections can be checked.

You can check status of thumbnail and Content Text Search data creation for sec-
tions. If necessary, you can create them again.

Document type

For ScanRouter DocumentServer, ScanRouter V2 Lite/Professional, ScanRouter
Enterprise, and ScanRouter EX Professional/Enterprise, [Document Type] is avail-
able on the [Summary] tab in the document properties dialog box.

Each cabinet can be configured to hold documents with certain document types.
By separating documents according to document type, document management
becomes easier.

In addition to the basic document type, ScanRouter specific document types are
available with ScanRouter. Documents added from input devices by way of
ScanRouter V2 Lite/Professional, ScanRouter Enterprise, and ScanRouter EX
Professional/Enterprise can be configured as ScanRouter specific documents.
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Document type in ScanRouter DocumentServer

Using ScanRouter DocumentServer, you can configure document type. Dis-
played items on the [Summary] tab in the properties dialog box may differ de-
pending on the document type. By configuring document type, efficient
management of various kinds of documents becomes possible. Each document
can only be configured as one document type. Document types must be created
by the administrator in advance.

Document type of in-tray documents

Each document delivered in the in-tray of ScanRouter V2 Lite/Professional,
ScanRouter Enterprise, and ScanRouter EX Professional/Enterprise has a specif-
ic document type depending on the capture method.

Displayed items on the [Summary] tab in the properties dialog box may differ de-
pending on the document type.

Document Shortcuts

Shortcuts of ScanRouter DocumentServer documents

Using ScanRouter DocumentServer, you can create shortcuts to display fre-
quently used documents easily. For example, you can create a shortcut for a doc-
ument with a long path and paste it in a folder with a short path, or you can copy
a shortcut of a document with a long path and paste it in a DeskTopBinder fold-
er. By double-clicking the shortcut you can immediately display the document.
This allows easy access for frequently used documents.
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Security for Document

ScanRouter DocumentServer, ScanRouter V2 Lite/Professional, ScanRouter En-
terprise, and ScanRouter EX Professional/Enterprise have the following securi-
ty functions to restrict access to documents viewed and used by multiple users.

Security and access rights in ScanRouter DocumentServer

Each ScanRouter DocumentServer cabinet and folder has an access control list
(ACL) to limit user access and the operations users can perform.

Configuring access rights for each cabinet or folder restricts access and prevents
unwanted document tampering. Various kinds of access rights are available, in-
cluding, viewing only, editing, and deleting.

1. Document

2. Trash can

3. No access rights

4. Viewing possible

5. Editing possible

6. Deleting possible

Note

❒ ScanRouter DocumentServer Ver.1.XXX restricts user access by passwords
configured for each cabinet.

❒ Individual ScanRouter DocumentServer Ver.2.XXX documents and shortcuts
do not have ACL. However, access to them can be controlled by the same
ACL settings configured for the cabinet or folder where they are stored.

2

1

3 4 5

6

ANL017S
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Security and access rights in ScanRouter EX Professional/Enterprise

Each ScanRouter EX Professional/Enterprise in-tray has an access control list
(ACL) to restrict users and the operations they can perform. Configuring access
rights for each in-tray restricts viewers and prevents unwanted document tam-
pering. Only users who have specific access rights can access documents in an
in-tray to view and copy them to a client computer.

Note

❒ ScanRouter V2 Lite/Professional and ScanRouter Enterprise restrict user ac-
cess using passwords configured for each in-tray.
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2. Let's Start Using DeskTopBinder

Introduction

Before using DeskTopBinder, read this chapter to understand the basic opera-
tion of DeskTopBinder.

The explanations in this chapter are limited to the operations available inside My
Cabinet, although DeskTopBinder enables users to share documents in the serv-
er by connecting to ScanRouter DocumentServer.
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Starting and Quitting DeskTopBinder

Starting

A Click [Start], and then point to [All Programs] or [Programs].

B Point to [DeskTopBinder], and then click [DeskTopBinder].

DeskTopBinder starts.
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Note

❒ Extended Features Wizard appears when DeskTopBinder is started. Add
functions such as input functions, print functions, and network locations
as needed.

❒ In the first dialog box of Extended Features Wizard, if you select the [Do not
show this screen when launching DeskTopBinder] check box, Extended Features
Wizard will not be shown when you subsequently start DeskTopBinder.

Reference

For details about Extended Features, see p.41 “Extended Features of Desk-
TopBinder”.

Quitting

A On the [File] menu, click [Exit].

DeskTopBinder exits.

Note

❒ When the [Display list of expired documents on exit] check box in the [My Cabi-
net Properties] or [Removable Cabinet Properties] dialog box is selected, the
documents are searched for and the Expired Document list appears when
you quit DeskTopBinder. In the Expired Document list, you can delete un-
necessary documents.

❒ When the [Delete Job Binding documents 24 hours after they were created] check
box in the [Job Binding (RPCS Printer) Properties] dialog box is selected, a con-
firmation message about deleting the documents appears when you quit
DeskTopBinder.
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Basic Operations

This section explains the following basic document operations frequently per-
formed using DeskTopBinder.

Follow the procedures below to start operating DeskTopBinder.

• Adding Documents

• Displaying Documents

• Printing Documents

• Searching for Documents

• Editing Documents

Adding Documents

Although various methods are available to add documents to DeskTopBinder,
adding files from Windows Explorer using a drag-and-drop operation and add-
ing documents using a scanner are described as examples.

When an original is scanned using a scanner, the image data of the scanned orig-
inal can be added to DeskTopBinder as a document.

When a file is added from Windows Explorer, the file can be added to DeskTop-
Binder as a document. The file format remains unchanged from when the file
was created with an application.
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Adding files using a drag-and-drop operation

A Drag a file from Windows Explorer and drop it in a folder in the tree pane
of DeskTopBinder, or drop it in the document list pane.

B On the menu, click [Copy Here] or [Move Here]. 

The document is added.
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Adding documents using a scanner

Important

❒ To add documents using a scanner, a TWAIN driver compliant with the scan-
ner must be installed in a client computer beforehand.

A In the tree pane, select the folder where you want to add the document.

B On the [File] menu, point to [Add Document], and then click [Scan...].
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Viewer starts and the dialog box for scanner settings appears.

CMake the necessary scanner settings, and then scan.

The confirmation message about completing the scan appears.

D Click [Complete].

E On the [File] menu of Viewer, click [Exit].
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The [Enter Document Properties Summary] dialog box appears.

F Enter document properties, and then click [OK].

Viewer quits and the scanned original is added as a document.

Note

❒ When documents cannot be added using a scanner, check that the scanner
- compliant TWAIN driver is installed in a client computer, or Scan is con-
figured from Extended Features.

Reference

For details about Extended Features, see p.41 “Extended Features of Desk-
TopBinder”.
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Displaying Documents

Three methods are available to display documents: using Easy Viewer, using
Viewer, and using an application.

When a document is displayed using Easy Viewer, leafing through documents
is possible. This allows searching for necessary documents by checking the con-
tents of documents.

When a document is displayed using Viewer, various operations can be per-
formed for specified files (sections) that make up the document.

When a document is displayed using the application used to create it, editing the
contents is possible.

Displaying documents using Easy Viewer

A In the document list pane, select the document you want to display.

B On the [View] menu, click [Easy Viewer], or click , the [Easy Viewer] button.

Easy Viewer starts and the document is displayed.
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Displaying documents using Viewer

A In the document list pane, select the document you want to display.

B On the [Document] menu, click [Open in Viewer].

Viewer starts and the document contents are displayed.
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Displaying documents using an application

A In the document list pane, select the document you want to display using
an application.

B On the [Document] menu, click [Open in Application].

The application starts and the document is displayed.
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Limitation

❒ Up to 8 applications can be started on the Desk at the same time.

❒ Up to 8 applications can be started from Viewer at the same time.

❒ When multiple Viewers are running, up to 8 applications can be started
from each Viewer.

Searching for Documents

Documents can be searched through information set in document properties.

Two methods are available to search for documents: Broad Search and Specific
Search.

Broad Search enables searching for documents by words or date, and Specific
Search enables searching for documents using more specific conditions.

Also, there are two types of Specific Search: Content Text Search and Keyword
Search. Content Text Search enables searching for all sections of documents that
have Content Text Search data. Keyword Search enables searching for docu-
ments by setting search conditions.

The procedures for Broad Search and Content Text Search are described as ex-
amples.

After a search is complete, documents are listed in the [Search Results List - Desk-
TopBinder Professional] window. Displaying and printing documents is also avail-
able from the window.
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Searching for documents with Broad Search

A In the tree pane, select the cabinet or folder you want to search through.

B On the [File] menu, click [Broad Search], or click , the [Broad Search] button.

The [Broad Search] dialog box appears.

CMake the necessary search settings in the [Search string(s)] box or in other
items, and then click [Search].

The confirmation message about completing the search appears.

D Click [List Results].
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The [Search Results List - DeskTopBinder Professional] window appears and the
documents found are displayed in the list.

E On the [File] menu, click [Close].

The [Search Results List - DeskTopBinder Professional] window closes.
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Searching for documents with Content Text Search

A In the tree pane, select the cabinet or folder you want to search through.

B On the [File] menu, click [Specific Search], or click , the [Specific Search] but-
ton on the toolbar.

The [Specific Search - My Workroom] dialog box appears.

C Click [Content Text Search].
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DMake the necessary search settings in the [Location(s) to search] and [Search
string(s)] boxes, and then click [Search].

The confirmation message about completing the search appears.
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E Click [List Results].

The [Search Results List - DeskTopBinder Professional] window appears and the
documents found are displayed in the list.

F On the [File] menu, click [Close].

The [Search Results List - DeskTopBinder Professional] window closes.
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Printing Documents

In addition to ordinary printing, printing with Easy Print and other print meth-
ods are available.

Use the Print function of DeskTopBinder to create previews and make detailed
print settings.

When DeskTopBinder is incorporated with SmartDeviceMonitor for Client, the
[Notification] dialog box can be displayed at print job completion or if an error oc-
curs during printing.

The procedures for displaying a preview to make detailed print settings includ-
ing Layout and Duplex and printing after you have checked the print conditions,
and making notification settings in the [Extended Features Settings] dialog box of
SmartDeviceMonitor for Client are described as examples.

Printing

Important

❒ To display previews before printing documents, an RPCS printer driver that
supports the preview display function must be installed on a client computer
beforehand.

Note

❒ To display previews, under DeskTopBinder Extended Features, in the [Print
Properties] dialog box, the [Perform advanced print settings on the corresponding
printer.] check box must be selected beforehand.

A In the document list pane, select the document you want to print.

B On the [File] menu, click [Print...], or click , the [Print] button on the tool-
bar.

The [Print] dialog box appears.
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CMake the necessary print settings after previewing with the print settings
including Layout and Duplex.

Note

❒ Click [Create Preview] to display a preview of the document.

❒ Some functions might not be available, depending on the printer driver
you are using. For details about which functions are available with which
printer driver versions, see the Compatible Device List.

D Click [Print].

Printing starts.

Reference

For details about Extended Features, see p.41 “Extended Features of Desk-
TopBinder”.
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Receiving Notifications

Follow the procedure below to display the [Notification] dialog box if a print job
finishes or an error occurs during printing.

A Click [Start], and then point to [Programs].

B Point to [DeskTopBinder], point to [SmartDeviceMonitor for Client], and then click
[Extended Features Settings].

The [Extended Features Settings] dialog box appears.

C Select the [Use Extended Features] check box.
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D In the [Notification] area, select when you want to display the [Notification] di-
alog box, and then click [OK].

In the [Notification] area, you can set the following items:

• Notify of printout/data-transmission/cancellation.
Sends a notification when transmission of data to a printer is complete,
printing finishes, or a print job is canceled.

• Notify when errors occur while printing
Sends notification of print results if an error occurs during printing.

• Notify of printout/data-transmission when using print server
Sends notification of printing results when a print job is sent from the print
server. 

• Display [Notification] on top
Displays the [Notification] dialog box over other windows.

Important

❒ When the [Notification] check box is selected, to receive notification, Smart-
DeviceMonitor for Client must be used for printing from the print server.
Also, the setting for notifying a client computer of the printing result must
be made on the print server.

Limitation

❒ If the settings for notifying of print completion and errors occur during
printing are made using the printer driver, those settings have the priority
over the settings made here.
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Editing Documents

Documents can be edited by two methods: by starting Viewer, or by starting the
application used to create the document.

Using Viewer, operations such as changing order and rotating are possible for
files (sections) that make up the document. For image files: inserting text, draw-
ing figures, and other image processing functions are possible.

Using the application the document was created in, specific files in the docu-
ment can be edited in detail.

The procedures for inserting text into an image, editing the text, and moving an
enclosed area on an image using Viewer are described as examples.

Inserting text into an image

A Display an image document using Viewer.

B Click [Edit Image].

The Edit Image toolbar and the [Graphics] menu appear.

C On the Edit Image toolbar, click , the [Insert Text] button, or on the [Graph-
ics] menu, point to [Draw], and then click [Insert Text].

This changes the pointer to .
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D Drag to draw a box for entering text.

A text box is displayed and a cursor appears inside it.

E Enter text.

F Click , the [Select Image Objects] button, or another button for figure ob-
jects to quit inserting text.
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G To change text properties settings, such as font, size, and text color, click
, the [Select Image Objects] button, and then click the text.

The text box is selected.

H On the [Graphics] menu, click [Properties...].
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I In the [Text Properties] dialog box, change the font, size, color, alignment,
and other text settings.

J Click [OK] to quit changing the text properties.

The text properties are changed.
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K Click [Quit Editing Image].

The dialog box for selecting a saving method appears.

L Select a saving method, and then click [OK].

Note

❒ Changes made in the [Text Properties] dialog box are applied to all charac-
ters in the text box.



Basic Operations

39

2

Moving an enclosed area in an image

A Display an image document using Viewer.

B Click [Edit Image].

The Edit Image toolbar appears.

C On the Edit Image toolbar, click , the [Select Range] button.

This changes the pointer to .
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D Drag to draw a rectangle to enclose the desired area. 

The specified area is enclosed by a dotted rectangle.

E Place the pointer on the enclosed image.

This changes the pointer to .

FWhile pressing the left mouse button, drag the enclosed image to the de-
sired position.

G Click [Quit Editing Image].

The dialog box for selecting a saving method appears.

H Select a saving method, and then click [OK].
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3. Extended Features of
DeskTopBinder

Extended Features

Extended Features settings are required for various DeskTopBinder functions.

To perform document operations in cooperation with ScanRouter V2 Lite/Pro-
fessional, ScanRouter Enterprise, ScanRouter EX Professional/Enterprise, Scan-
Router DocumentServer, or Document Server (MFP), they must be added as
network locations from DeskTopBinder Extended Features.

After they are configured as network locations, the icons for network locations
appear under the DeskTopBinder tree.

Using Extended Features, you can also configure input/output functions, con-
version functions, and tools to use them with DeskTopBinder.

You can also change properties of functions and delete unnecessary functions.

Before using DeskTopBinder, be sure to add and configure functions from Ex-
tended Features.
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Operations in Extended Features

Settings for Network Locations

The related devices or programs are displayed under the DeskTopBinder tree
and can be used in cooperation with DeskTopBinder.

Using these devices or programs, the following are possible:

• Control Windows Document with DeskTopBinder

• Control documents in ScanRouter DocumentServer *

• Create shared cabinets to make DeskTopBinder documents available for mul-
tiple users *

• Create removable cabinets that can be used in other client computers *

• In cooperation with ScanRouter, control documents in in-trays

• Control documents in Document Server (MFP)

• Control documents in Job Binding (RPCS Printer)

Limitation

❒ If you are using DeskTopBinder Lite, you cannot make settings for functions
marked "*".

Reference

For more information about possible functions incorporated with network lo-
cations, see DeskTopBinder Help.
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Procedure for adding network locations

Start DeskTopBinder, and then click [Extended Features...] on the [Tools] menu.

The procedure for adding a network device Document Server (MFP) is given
here as an example.

When Document Server (MFP) is added, documents in Document Server (MFP)
can be viewed and managed using DeskTopBinder.

Reference

For setting procedures for other functions, see DeskTopBinder Help.

A On the [Tools] menu, click [Extended Features...].

In the [Extended Features...] dialog box that appears, a list of selectable func-
tions appears in the [Selectable function(s)] list.
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B Click the Network icon, and then select [Document Server (MFP)] in the [Select-
able function(s)] list.

C Click [Add...].

The [Document Server (MFP) Properties] dialog box appears.

D Click [Browse...] to select a network device, or click [Specify...] to enter the IP
address of the network device, and then click [OK]. Enter a user name, user
code, and other information as required.

[Document Server (MFP)] is displayed in the [Available function(s) to use] list.

E Click [OK].
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Input Functions

In Input of DeskTopBinder Extended Features, Scan and Easy Scanning settings
are available.

These settings enable you to add scanned images as documents.

Important

❒ To make scanner settings, a TWAIN driver compliant with the scanner must
be installed in the client computer.

Output Functions

In Output of DeskTopBinder Extended Features, you can make settings for the
following functions:

• Easy Print*1

• Print*1

• Send by E-mail

• Send by Fax*2

• Deliver

• Save in Job Binding*1

• PDF Direct Print

Important

❒ You can make settings for functions marked "*1" only if the printer driver in-
stalled on the client computer supports those functions.

❒ You can make settings for the function marked "*2" only if the printer driver
installed on the client computer supports that function.

Conversion Functions

In Convert of DeskTopBinder Extended Features, you can make settings for
Convert to Image, Convert to PDF, and Convert to Text (with OCR).
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Tool Functions

Advanced DeskTopBinder operations are possible using the tool functions in
Tools from DeskTopBinder Extended Features. 

You can make settings for the following functions:

• Export Document Properties Summary in CSV format

• Entry Assistant

• Import HTML

• Export HTML

• Print Document Properties Summary by List

• Print Document Image List

Settings in Extended Features Wizard

Start Extended Features Wizard for settings.

New functions can be added by selecting [Extended Features...] on the [Tools]
menu or using Extended Features Wizard.

With Extended Features Wizard, select [Easy settings] or [All function settings] as
the method for adding functions.

❖ Easy settings
[Easy settings] enables the settings for functions with a simple operation by
following the instructions on the display.
However, functions that can be configured are the following:

• Print functions

• Scanner functions

• Document Server (MFP)

• Connection to document management servers

• Connection to delivery servers

Limitation

❒ If you are using DeskTopBinder Lite, you cannot make settings for the doc-
ument management server.

❖ All function settings
[All function settings] enables the addition and setting of all functions.
The operation for [All function settings] is the same as that performed from the
Extended Features menu ([Extended Features...] on the [Tools] menu).
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Starting Extended Features Wizard

A Click [Start], and then point to [All Programs] or [Programs].

B Point to [DeskTopBinder], and then click [Extended Features Wizard].

The [Extended Features Wizard] dialog box appears.

Note

❒ Right-clicking the Function Palette icon on the task bar is another way to
start Extended Features.

❒ In the first dialog box of Extended Features Wizard, if you did not select
the [Do not show this screen when launching DeskTopBinder] check box, Extend-
ed Features Wizard will thereafter always appear when you start Desk-
TopBinder.
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Procedures for settings in Extended Features Wizard

Follow the procedure below described as an example of making function set-
tings using [Easy settings].

A Start Extended Features Wizard.

B Click [Easy settings], and then click [Start].

The [Printing Function1] dialog box appears.

Limitation

❒ If you are using DeskTopBinder Lite, you cannot make settings for the doc-
ument management server.
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CMake the necessary settings for print functions, and then click [Next>].

The [Printing Function2] dialog box appears.

DMake the necessary PDF Direct Print settings, and then click [Next>].

Limitation

❒ Only printers that support PDF Direct Print can be used.

The [Scanner Function] dialog box appears.
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EMake the necessary settings for scanner functions, and then click [Next>].

Important

❒ To make scanner function settings, a TWAIN driver compliant with the
scanner must be installed in a client computer beforehand.

The [Document Server (MFP)] dialog box appears.

FMake the necessary settings for Document Server (MFP), and then click [Next>].

Limitation

❒ You may be asked for a password depending on the network device you
are connecting. For more information about the password, consult the ad-
ministrator of the network device.

The [Document Management Server Connection] dialog box appears.
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GMake the necessary settings for document management servers to be con-
nected, and then click [Next>].

Limitation

❒ The [Document Management Server Connection] dialog box does not appear in
DeskTopBinder Lite.

❒ You may be asked for a user name, password, and domain name depend-
ing on the document management server you are connecting. For more in-
formation about the user name, password, and domain name, consult the
administrator of the server.

The [Delivery Server Connection] dialog box appears.

HMake the necessary settings for delivery servers to be connected, and then
click [Next>].
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Limitation

❒ You may be asked for a user name, password, and domain name depend-
ing on the delivery server you are connecting. For more information about
the user name, password, and domain name, consult the administrator of
the server.

The [Completion of Extended Features Settings] dialog box appears.

I Check the Extended Features settings, and then click [Finish].

Limitation

❒ If there is no Document Server (MFP), document management server, and
delivery server on the network, Extended Features settings cannot be
made.
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4. Structure of DeskTopBinder

Structure of DeskTopBinder

DeskTopBinder consists of DeskTopBinder itself and the following: Function
Palette, Auto Document Link, and SmartDeviceMonitor for Client.

DeskTopBinder

DeskTopBinder can integrate various kinds of data, such as files made with dif-
ferent applications, scanned image data, and existing image files for total docu-
ment management.

If network locations are added from Extended Features, you can view and man-
age documents in ScanRouter V2 Lite/Professional, ScanRouter Enterprise, or
ScanRouter EX Professional/Enterprise in-trays, or ScanRouter DocumentServ-
er cabinets using DeskTopBinder.

Furthermore, when DeskTopBinder is used with input/output devices, adding
scanned-in documents and outputting (Print and Send by Fax) documents from
DeskTopBinder are available. Depending on the network devices, saved docu-
ments in Document Servers can be copied to DeskTopBinder. Documents in
Document Servers can also be printed and outputted from DeskTopBinder.

Function Palette

DeskTopBinder functions are displayed on Function Palette if these functions
are configured using DeskTopBinder Extended Features in advance. Without
starting DeskTopBinder, functions, such as printing and Convert to Image can
be used for Windows files, and scanned originals can be added as documents.
You can also use these functions by moving a file to the button on Function Pal-
ette using a drag-and-drop operation or by right-clicking a file.

Reference

For details about Function Palette, see p.79 “Using Function Palette”.

Auto Document Link

If delivery server in-trays, specific folders, Fax Received Files, and a Caplio dig-
ital camera are configured as monitored items, Auto Document Link transfer
documents or files in the items and add them to DeskTopBinder or ScanRouter
DocumentServer, or save them in other Windows folders.

Reference

For details about Auto Document Link, see p.93 “Using Auto Document
Link” or “Auto Document Link Guide”.
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SmartDeviceMonitor for Client

SmartDeviceMonitor for Client automatically searches for printers on the net-
work and sends print data directly from client computers to the printers without
using a print server. Furthermore, SmartDeviceMonitor for Client can monitor
printers configured for monitoring, send notification of printout completion and
errors occurring during printing, and perform Recovery Printing and Parallel
Printing.

Reference

For details about SmartDeviceMonitor for Client, see p.111 “Using SmartDe-
viceMonitor for Client”.
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5. Using Desk

Desk Display Layout

1. Menu bar

Use this to perform operations on the dis-
play.

2. Standard toolbar

Use this to perform standard function op-
erations such as searching, displaying
properties, and switching views.

3. Input toolbar

Use this to add existing files and scanned
documents.

4. My workroom

Displays My Cabinet, shared cabinets,
and removable cabinets.

5. Tree pane

Displays My Cabinet of DeskTopBinder
and network locations added using Ex-
tended Features. Just after installation,
only My Workroom is displayed.

6. Document list pane

Displays folders and documents in a cab-
inet or a folder selected from the tree.

7. Output toolbar

Use this for printing, sending by E-mail,
and fax transmission. Functions config-
ured using Extended Features are dis-
played.

8. Conversion toolbar

Use this to convert documents or sections
into images, PDF files, and text. Func-
tions configured using Extended Fea-
tures are displayed.

7
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Display Method of the Document List

The document list can be viewed in four formats: 

Thumbnails, Icons, Details, and Calendar. The following describes each view.

Limitation

❒ The document list of Windows Document cannot be displayed in the Thumb-
nails view and Calendar view.
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Thumbnails view

1. Folder icon

2. Folder or document name

3. Clip

When a document is composed of multi-
ple sections, a clip is displayed.

4. Section thumbnail

The section thumbnail is displayed.
Thumbnails may not be created for some
sections.

5. Section icon

Displays an icon of the application which
the section was created with.

6. [Previous Section] [Next Section] buttons

These buttons appear when a document
is composed of multiple sections. Use
them to move through the sections of a
document.

7. Note

Click this to view the marked section.
Double-click to display the [Note Con-
tents] dialog box.

8. Note Leaf

When six or more notes are attached to
one document, only five notes are dis-
played, and the Note Leaf buttons ap-
pear. Use these buttons to move through
the marked sections of a document.

9. Current section number/total sec-
tion number

Displays the current section number and
the total number of sections.

Note

❒ For details about displaying thumbnails of PDF documents for which security
settings are made, see DeskTopBinder Help.

1
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Icons view

1. Folder icon

2. Document icon

The document icon is displayed. When a
document is composed of multiple sec-
tions, the icon is displayed with a clip at-
tached.

3. Folder or document name

4. Total section number

Displays the total number of sections in
the document.

ANL003S
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Details view

1. Displayed items

Click each item to sort documents. In ad-
dition, the documents stored in the docu-
ment management server or an in-tray of
the delivery server can be displayed by
document type.

ANL004S

1
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Calendar view

• Monthly view

• Weekly view

1. [Monthly][Weekly] buttons

Click this to switch between the weekly
and monthly calendar.

2. [Specify Date] button

Displays the month or week including
the specified date.

3. [Today] button

Displays the current month or week.

4. [Calendar Settings] button

Select Monday or Sunday as the first day
of the week on the calendar.

5. [Added] [Modified] [Created] date

Select to display by the added date or
modified date of the document.

ANL005S

1
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Note

❒ You can directly change a folder or document name in My Cabinet, shared
cabinets, or removable cabinets by clicking its name.

❒ To show the unread status of a document, the unread mark  is displayed
in the Thumbnails view and is shown in red in the Details view.
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Operations for Documents

Displaying Contents of a Document

The following methods are available to display the contents of a document:

• Using Easy Viewer
In the document list pane, select a document to display, and then click [Easy
Viewer] on the [View] menu, or click , the [Easy Viewer] button on the toolbar.
You can start Easy Viewer from the document properties dialog box also.

• Using Viewer
In the document list pane, select a document to display, and then click [Open
in Viewer] on the [Document] menu.

Note

❒ You can double-click an exported document link file (.RDL) in a client
computer to start Viewer.

• Using an application
Three methods are available:

• In the Thumbnails view of the document list, select the section to display
using an application, and then click [Open in Application] on the [Document]
menu.

• In the Icon view, Details view, or Calendar view, click [Open in Application]
on the [Document] menu.

• Double-click a file created with an application.

Note

❒ When a document consists of multiple sections, the application used to cre-
ate the first section starts - except when a section can be selected in the
Thumbnails view. To display a second or later section, display the docu-
ment using Viewer, select the section to display using an application, and
then click [Open in Application] on the [Document] menu or double-click the
section.
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Structure of Easy Viewer

Using Easy Viewer, you can easily display the contents of a document section by
section.

The size of the [Easy Viewer] window is changeable.

1. [Previous Section][Next Section] but-
tons

Click these buttons to move through the
sections of a document.

2. [Open Viewer] button

Click this to start Viewer. Easy Viewer is
closed.

3. Current section number/total sec-
tion number

Displays the current section number and
the total number of sections.

4. [Fit to Width] button

Fits the current section to the width of the
window.

5. [Fit in Window] button

Fits the current section to the overall size
of the window.

6. [Launch] button

Launches an application. Easy Viewer is
closed.

7. [Previous Document][Next Document]
buttons

Use these buttons to move from docu-
ment to document.

8. [90°Left][90°Right][180°] buttons

Click these buttons to rotate a displayed
section image. The rotated image cannot
be saved.

9. Section name

ANL007S
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Adding Documents

To add a document, start from the [File] menu or Input toolbar. 

The following methods are available:

Reference

For details, see DeskTopBinder Help.

• Create a new file using an application
A new file created with an application is added as a document.

• Add a file as a document
An existing file is added as a document. You can use the drag-and-drop op-
eration.

• Add a document using a scanner
A scanned image is added as a document.

• Add a document using Easy Scanning
Configure the scan-input conditions in advance. The image scanned with an
Easy Scanning compliant scanner is added as a document.

Important

❒ Scan or Easy Scanning settings must be configured using Extended Features.

Displaying Document Properties

To display a document's properties, select a document, and then click [Proper-
ties...] on the [File] menu, or click , the [Properties] button on the toolbar. You
can then view and change information about the document and/or its sections.

From the document properties dialog box, you can start Easy Viewer to view a
document's content and create thumbnails and Content Text Search data. For de-
tails about document properties, see p.9 “Document Properties”, or DeskTop-
Binder Help.

Note

❒ The properties dialog box of ScanRouter DocumentServer Ver.2.XXX docu-
ments contains the functions available in the properties dialog box of Desk-
TopBinder documents (in My Workroom) plus the following:

• Buttons that enable the properties dialog box to change its content auto-
matically without having to close, which allows you to check the proper-
ties of other documents displayed in the document list pane.

• A function that enables Easy Viewer to change its display automatically,
reflecting the content of the dialog box (when Easy Viewer is displayed
from the document properties dialog box).
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Searching for Documents

To search for documents, start from the [File] menu or Standard toolbar.

The following methods are available:

• Specific Search
Searches using keywords or Content Text Search data

• Broad Search
Searches only using words or date

Note

❒ With ScanRouter DocumentServer (Ver.2.XXX), Advanced Search is available
to refine the search.

❒ With ScanRouter DocumentServer (Ver.2.XXX), the folder search function is
also available.

Arranging Documents

The following methods are available to arrange documents from DeskTopBind-
er:

• Display properties
You can check the document properties and document type.

• Create thumbnails
When section thumbnails are created, you can find and view documents in
the Thumbnails view.

• Combine/separate documents
Use to combine multiple documents or to separate multiple DeskTopBinder
documents into one-section documents.

• Add/delete a note and change note contents
Adding or deleting a note on a section makes document arrangement easier.
You can change the color of a note and enter a comment.

• Create Content Text Search data
Use to create Content Text Search data.

Limitation

❒ Content Text Search data cannot be created using DeskTopBinder Lite.
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Printing/Outputting/Converting Documents

To print, output, or convert documents, start from the [File] menu, the Output
toolbar, or the Conversion toolbar.

❖ Print/Output
The following methods are available to print or output documents:

• Export as files*1

• Print using Easy Print*1, *2

• Send by E-mail

• Fax transmission (Send by Fax)

• Deliver by ScanRouter delivery server*1

• Save in Job Binding*2

• PDF Direct Print*1

• Print*2

Important

❒ Functions marked "*1" must be configured using Extended Features.

❒ You can make settings for the functions marked "*2" only if the printer driver
installed on the client computer supports those functions.

❒ To use Send by Fax, a LAN-Fax driver is required. 

❒ To use Send by E-mail, a supported mailer must be set as the default mail ap-
plication in Windows.

❒ The default printer changes temporarily in order to send faxes, print, perform
easyprint, convert images or PDF files, or save in Job Binder. While these jobs
are being processed, print jobs sent from other applications that have not
specified a printer might be faxed, output by easyprint, converted, or saved,
instead of printed. Before printing jobs from other applications, check the de-
fault printer is not faxing, printing, performing easyprint, converting images
or PDF files, or saving to Job Binder.

Reference

For information about supported fax drivers, see the DeskTopBinder Readme
file.

❖ Conversion
To convert documents, the following methods are available:

• Convert to Image

• Convert to PDF

• Convert to Text (with OCR)
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Important

❒ Convert to Image, Convert to PDF, and Convert to Text (with OCR) must be
configured using Extended Features.

Note

❒ The Convert to PDF function allows you to do the following to converted doc-
uments:

• Convert images to PDF files that have text data attachments.

• Convert full-color images to highly compressed PDF files.

• Configure PDF security settings.

Document Management (available when ScanRouter DocumentServer 
is connected)

Important

❒ For the following operations, ScanRouter DocumentServer must be added
from Extended Features beforehand.

Adding/Deleting Document Management Server cabinets

You can add ScanRouter DocumentServer cabinets to be used with DeskTop-
Binder as needed. You can also delete unnecessary cabinets.

To add a cabinet, select ScanRouter DocumentServer in the tree pane. On the
[File] menu, point to [Cabinet], and then click [Add to Tree...].

To delete a cabinet, select the cabinet you want to delete from the tree. On the
[File] menu, point to [Cabinet], and then click [Remove from Tree].

Document management with document management server

The following document operations are available only with ScanRouter Docu-
mentServer:

• Perform Auto-adjust Image Orientation*1,*2
To automatically recognize image orientation and adjust orientation.

• Extract text as document name*1,*2
To replace the current document name with text extracted from the first sec-
tion.

• Create Web Viewer Display data*2
To create Web Viewer Display data. When Web Viewer Display data is creat-
ed, documents can be viewed using ScanRouter Web Navigator through a
Web browser.
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• Create PDF display data*2
Use to create PDF data. With PDF data, documents can be displayed clearly
using Acrobat Reader even if the application used to create the document is
not installed in a client computer.

• Manage versions*2
You can manage document update history. It is also possible to check the
background of the update and the user who updated the document by con-
figuring notes for each version.
Managing versions is also possible from Viewer.

• Change access rights*2
To change access rights to configure operations each user can perform for
folders or documents.

*1 - Functions available with ScanRouter DocumentServer (Ver.1.XXX)

*2 - Functions available with ScanRouter DocumentServer (Ver.2.XXX)

Limitation

❒ Some functions may not be available depending on the type and version of
the connected document management server.

Checking and Transferring Newly Arrived Documents

Using Auto Document Link, files from the following monitored items can be
transferred and added to DeskTopBinder and ScanRouter DocumentServer as
documents, or saved to Windows folders as files: delivery server in-trays, spec-
ified Windows folders, Fax Received Files of network devices, and a Caplio dig-
ital camera.

There are two methods for transfer: transferring automatically and transferring
manually.

Reference

For details about Auto Document Link, see “Auto Document Link Guide”.

• Settings for transfer
On the [Tools] menu, point to [Auto Document Link], and then click [Properties].
In the [Auto Document Link Properties] dialog box, select the item to be moni-
tored, and then make the necessary settings.

• Automatic transfer
Documents or files in the monitored items are transferred automatically to
the specified locations with the settings in the [Auto Document Link Properties]
dialog box.
To transfer documents or files automatically, Auto Document Link must be
started.
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• Manual transfer
On the [Tools] menu, point to [Auto Document Link], and then click [Check New
Data].
Documents or files in the monitored items are transferred to the specified lo-
cations with the settings in the [Auto Document Link Properties] dialog box.

Note

❒ Auto Document Link can also be started from the [Start] menu of Windows.

❒ The icon of Auto Document Link appears on the taskbar when you start Desk-
TopBinder. Right-click the icon. You can also make settings and check new
data from the menu.
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6. Using Viewer

Structure of the Viewer Display

The structure of Viewer display changes according to the type of section being
displayed and the network location.

This section explains the display structure of Viewer using the example of dis-
playing a document in My Workroom.

Note that if you use Viewer to display a document that is stored in the document
management server, the buttons that are specific to the document management
server are also available, along with the Viewer display structure for My Work-
room documents. For details, see p.73 “Document Management Server Docu-
ment Viewer Display”.

❖ Image section display

❖ PDF section display

AUM001S

AUM002S
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❖ Application file section display

1. Menu bar

Use this to perform operations on the dis-
play.

2. Standard toolbar

Use this to perform standard function op-
erations such as switching sections and
adding notes.

3. Input toolbar

Use this to add new images, existing files,
and scanned documents.

4. Image Viewing toolbar

Use this to zoom in, zoom out, or rotate
an image.

Click [Edit Image] to display the drawing
toolbar.

5. Note

Use this to attach or delete a note, or to
change the note contents.

6. Section name

Use this to change the section name.

7. Section list pane

The section thumbnail list in a document
is displayed.

8. Output toolbar

Use this for printing, sending by E-mail
and fax transmission. Functions config-
ured using Extended Features are dis-
played.

9. Drawing toolbar

Use this to draw lines, polygons, and cir-
cles and perform masking on an image.

10. Conversion toolbar

Use this to convert documents or sections
into images, PDF files, and text. Func-
tions configured using Extended Fea-
tures are displayed.

11. Section pane

The contents of the currently selected sec-
tion are displayed.

12. PDF toolbar

Use this to perform PDF operations such
as displaying bookmarks, notes, and a
page list, and rotating and moving pages.
When a text PDF file is displayed, you
can search, select, and copy its text.

If you start Viewer from a Content Text
Search results list, words matching the
search conditions appear highlighted in
the displayed PDF file.

13. Section View pane

If you use Viewer to display an applica-
tion file, you can display the file in sim-
plified form. The simplified display is
less detailed than when the file is dis-
played using an application, and you
cannot edit or use other functions on the
file when it is displayed in simplified
form.

AUM003S
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Note

❒ To disable the simplified application file display, in the [Viewer Preferences] di-
alog box, on the [View] tab, select the [Do not show simplified file display] check
box. (This check box is unavailable in DeskTopBinder Lite.)

❒ To edit application files, select an application file section, and then, on the
[Section] menu, click [Open in Application]. The selected section opens using the
appropriate application.

Document Management Server Document Viewer Display

The buttons below are available on the Viewer display when a document man-
agement server document is displayed using Viewer. Other items are the same
as the Viewer display for documents in My Workroom. For details, see p.71
“Structure of the Viewer Display”.

1. [To Update Mode]/[Exit Update Mode]
button

Click [To Update Mode] to enter the mode
that enables you to edit documents. You
can perform updating operations, such as
inserting, replacing, moving, and editing
sections.

Click [Exit Update Mode] to quit Update
mode.

2. [Original Data] button

Click this to edit the original data of an
image section.

If you display a PDF file section, you can
perform text searches and change the dis-
play method using the PDF toolbar.

If you display an application file section,
it will be displayed in simplified form.

3. [PDF Data] button

If a section has PDF display data, click
this button to display the section in PDF.

You can perform text searches and
change the display method using the
PDF toolbar.

Limitation

❒ [Original Data] and [PDF Data] appear only when a document in ScanRouter
DocumentServer Ver.2.XXX is displayed.

AUM004S
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Managing Sections

Reference

For more information, see DeskTopBinder Help.

Changing the Section Order

To change the section order, use the [Section] menu, or move a section thumbnail
in the thumbnail pane using a drag-and-drop operation.

Inserting/Replacing a Section

To insert or replace a section, start from the [File] menu. 

The following types of data can be inserted or replaced:

• New images (blank image file)

• Data imported from a file

• Image data scanned with a scanner

• Clipboard images

• Data captured from added documents

• Image data scanned using Easy Scanning

Important

❒ To insert or replace a section in a ScanRouter DocumentServer document, you
must first switch to the Update Mode.

❒ To use a Scan or Easy Scanning to insert or replace a section, you must first
configure them using Extended Features.

Limitation

❒ New images can only be inserted. Replacing an existing section with a new
image is not possible.
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Printing/Outputting/Converting a Section

To print, output, or convert a section, start from the [File] menu, the Output tool-
bar, or the Conversion toolbar.

❖ Print/Output
The following methods are available to print or output sections:

• Export as files*

• Send by E-mail

• Deliver by ScanRouter delivery server*

• Print using Easy Print*

• Fax transmission (Send by Fax)

• Save in Job Binding

• PDF Direct Print*

• Print

Important

❒ Functions marked "*" must be configured using Extended Features.

❒ The default printer changes temporarily in order to send faxes, print, perform
easyprint, convert images or PDF files, or save in Job Binder. While these jobs
are being processed, print jobs sent from other applications that have not
specified a printer might be faxed, output by easyprint, converted, or saved,
instead of printed. Before printing jobs from other applications, check the de-
fault printer is not faxing, printing, performing easyprint, converting images
or PDF files, or saving to Job Binder.

❖ Conversion
The following methods are available to convert sections:

• Convert to Image

• Convert to PDF

• Convert to Text (with OCR)

Important

❒ To use Convert to Image, Convert to PDF, and Convert to Text (with OCR),
you must first configure them using Extended Features.

Note

❒ The Convert to PDF function allows you to do the following to converted sec-
tions:

• Convert images to PDF files that have text data attachments.

• Convert full-color images to highly compressed PDF files.

• Configure PDF security settings.
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Editing an Image Section

To edit an image, click [Edit Image] on the [Section] menu or Image Viewing tool-
bar.

To draw a figure, start from the [Graphics] menu or Drawing toolbar.

The following are available for editing an image:

• Insert Text

• Comment

• Stamp

• Date Stamp

• Insert Illustration

• Straight Lines

• Horizontal/Vertical Lines

• Squares/Rectangles

• Rounded Rectangles

• Ovals

• Polygons

• Freehand

• Masking

Important

❒ To use Masking, you must first make settings for Masking using Viewer Pref-
erences.
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Image Processing

You can use the following functions on image sections.

Important

❒ Before using these functions on image sections, set the mode to Edit Image
mode.

❖ Image processing
The following functions are available on the [Image] menu:

• Enclosed area functions
Fill, Move, Copy, Cut, Zoom In/Out, Invert Image Color, Trimming

• Erasing an image (eraser)

• Rotating an image

• Reduce Noise

• Enhance Image

• Show-Through Correction

• Correct Skew (corrects angles)

• Image Correction (corrects brightness and contrast)

• Resize

❖ Camera Image Processing
The following functions for camera-captured digital images are available
from [Camera Image Processing] on the [Section] menu:

• Distortion Correction (corrects peripheral distortion)

• Peripheral Light Intensity Correction (corrects peripheral brightness)

• View Shot Information

• Browse/Edit Camera Memo

• Playing voice recorded in a camera memo
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7. Using Function Palette

Function Palette Features

Function Palette is available on computers with DeskTopBinder installed. Input,
output, and convert functions of DeskTopBinder are displayed as buttons on
Function Palette if these are configured in advance using DeskTopBinder Ex-
tended Features. By clicking a button on Function Palette, operations such as
scanning and adding a document can be performed without starting DeskTop-
Binder. Some of these operations such as Print and Convert to Image can also be
performed by dropping a Windows file on a button using the drag-and-drop op-
eration.

Important

❒ To use the functions described above with Function Palette, you must first
configure them using Extended Features Wizard or from DeskTopBinder Ex-
tended Features.
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Starting and Quitting

Starting

A Click [Start], and then point to [All Programs] or [Programs].

B Point to [DeskTopBinder], and then click [Function Palette].

Function Palette starts, and the icon appears on the taskbar. The palette ap-
pears on desktop.

Note

❒ If Function Palette is selected to be added to the startup menu when install-
ing DeskTopBinder, Function Palette automatically starts when you log on
to Windows.
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Quitting

A Right-click the icon on the taskbar, and then click [Exit] on the menu.

Function Palette exits.
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Structure of Function Palette

There are two types of Function Palette: Function Palette and taskbar icon.

Function Palette

Buttons for input, output, and convert functions specified in Properties are dis-
played on the desktop.

When you click a button on Function Palette or drop a file on a button using the
drag-and-drop operation, the following operations are available:

❖ Input:
Scan, Easy Scanning

❖ Output:
Print, Send by E-mail, Deliver, Send by Fax, Save in Job Binding, PDF Direct
Print, Easy Print.

❖ Convert:
Convert to Image, Convert to PDF, Convert to Text (with OCR)

Note

❒ Settings for the display style of the buttons on Function Palette can be made
using Properties. On the taskbar icon menu, click [Properties].

❒ When you make changes to Extended Features settings, restart Function Pal-
ette, or display Properties, and then click [OK].
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Taskbar Icon

From the menu that appears when you right-click the taskbar icon, Function Pal-
ette properties settings and the following operations are available.

• Switch between display and non-display of Function Palette

• Perform input functions

• Perform output functions

• Perform convert functions

• Make Function Palette properties settings

• Start Extended Features Wizard

• Display Help

• Display version

• Quit Function Palette
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Setting Function Palette

Function Palette settings can be made using Function Palette properties. In the
[Properties] dialog box, the following operations are available:

❖ [Display] tab
Makes settings regarding the display style of Function Palette and the buttons.

❖ [Operation] tab
Makes settings regarding operation of Function Palette when printing and
outputting.

❖ [Contents] tab
Makes settings regarding the buttons displayed on Function Palette.

Follow the procedure below to make properties settings.

A On the menu that appears when you right-click the taskbar icon, click [Properties].

The [Properties] dialog box appears.

BMake the necessary Function Palette settings on each tab.

C Click [OK].
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Performing Document Management Using 
Function Palette

Adding Documents

Using Function Palette, scanning originals with a scanner and saving the data in
the specified location is possible.

Follow the procedure below to scan originals.

A Click the Function Palette [Scan] button, or on the taskbar icon menu, point
to [Input], and then click [Scan].

A dialog box for scanner settings appears.

BMake the necessary scanner settings, and then scan.

The confirmation message about completing the scan appears.

C Click [Complete].

The [Save As /Add As] dialog box appears.

D Specify a saving location, and then click [OK].

Scanned data is saved to the specified location.

Note

❒ The name of a document created by scanning automatically becomes "New
Scan", followed by the date and time and a serial number.

❒ If you want to make a series of scans, place the next original in step C.
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Outputting Documents

Printing and outputting Windows files is possible using Function Palette.

Follow the procedure described as an example of printing a file.

Printing from the menu or button

A Click the Function Palette [Print] button, or on the taskbar icon menu, point
to [Output], and then click [Print].

A dialog box for selecting a file appears.

B Select the file you want to print, and then click [OK].

The [Output File List] dialog box appears.

CMake file order settings for printing, and then click [OK].

A dialog box for printing appears.

DMake the necessary print settings.

E Click [OK].

Printing starts.
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Dragging files to the button

A Drag a file you want to print, and then drop it on the Function Palette [Print]
button.

The [Output File List] dialog box appears.

BMake file order settings for printing, and then click [OK].

A dialog box for printing appears.

CMake the necessary print settings.

D Click [OK].

Printing starts.

Note

❒ The [Output File List] dialog box appears only when the [Display dialog to
change the file order] check box is selected in Properties.

❒ Printing and outputting of DeskTopBinder documents is possible using
the drag-and-drop operation. This operation is available only for docu-
ments that can be exported.
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Right-clicking files in Windows Explorer

A Right-click a file you want to print, point to [Function Palette], point to [Out-
put], and then click [Print].

The [Output File List] dialog box appears.

B Select the file you want to print, and then click [OK].

A dialog box for printing appears.

CMake the necessary print settings.

D Click [OK].

Printing starts.
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Note

❒ The [Output File List] dialog box appears only when the [Display dialog to
change the file order] check box is selected in Properties.

Converting Documents

Converting files to image, PDF, and text format is possible using Function Pal-
ette. 

Follow one of the procedures below to convert a file to an image file.

Converting from the menu or button

A Click the Function Palette [Convert to Image] button, or on the taskbar icon
menu, point to [Convert], and then select [Convert to Image].

A dialog box for selecting a file appears.

B Select the file you want to convert, and then click [OK].

The [Conversion File List] dialog box appears.

CMake file order settings for conversion, and then click [OK].

The [Convert to Image] dialog box appears.

DMake the necessary convert settings, and then click [OK].

The [Save As /Add As] dialog box appears.

E Specify a saving method, and then click [OK].

The file is converted to an image file.
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Dragging files to the button

A Drag a file you want to convert, and then drop it on the Function Palette
[Convert to Image] button.

The [Conversion File List] dialog box appears.

BMake file order settings for conversion, and then click [OK].

The [Convert to Image] dialog box appears.

CMake the necessary convert settings, and then click [OK].

The [Save As /Add As] dialog box appears.

D Specify a saving method, and then click [OK].

The file is converted to an image file.

Note

❒ The [Conversion File List] dialog box appears when it is configured to be dis-
played in Properties.

❒ Converting of DeskTopBinder documents is possible using the drag-and-
drop operation. This operation is available only for documents that can be
exported.
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Right-clicking files in Windows Explorer

A Right-click a file you want to convert, point to [Function Palette], point to
[Convert], and then click [Convert to Image].

The [Conversion File List] dialog box appears.

B Select the file you want to convert, and then click [OK].

A dialog box for conversion appears.

CMake the necessary conversion settings, and then click [OK].

The [Save As /Add As] dialog box appears.
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D Specify a saving method, and then click [OK].

The file is converted to an image file.

Note

❒ The [Conversion File List] dialog box appears only when it is configured to
be displayed in Properties.
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8. Using Auto Document Link

Auto Document Link Features

Auto Document Link is available on computers with DeskTopBinder installed. 

Auto Document Link can monitor delivery server in-trays (ScanRouter V2
Lite/Professional, ScanRouter Enterprise, and ScanRouter EX Professional/En-
terprise) on the network, local Windows folders or shared network folders, Fax
Received Files of network devices, and a Caplio digital camera, and give notifi-
cation of documents or files on client computers.

Also Auto Document Link can automatically transfer these documents or files to
DeskTopBinder folders, ScanRouter DocumentServer folders, or Windows fold-
ers.

Reference

For details about Auto Document Link, see “Auto Document Link Guide”.
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Starting and Quitting

Starting

A Click [Start], and then point to [All Programs] or [Programs].

B Point to [DeskTopBinder], and then click [Auto Document Link].

Auto Document Link starts, and the Auto Document Link icon  appears on
the taskbar.

Note

❒ When no settings are made in Properties, the [Auto Document Link Properties]
dialog box appears.

❒ If Auto Document Link is selected to be added to the startup menu when
installing DeskTopBinder, Auto Document Link automatically starts when
you log on to Windows.
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Quitting

A Right-click the Auto Document Link icon  on the taskbar, and then click
[Exit].

Auto Document Link exits.
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Monitor Item Settings

Make monitor item settings in the [Auto Document Link Properties] dialog box.

While the item is being monitored or data in the monitored item is being trans-
ferred, properties cannot be set or changed.

A On the menu that appears when you right-click the icon on the taskbar,
click [Properties...], or on the [Tools] menu of DeskTopBinder, point to [Auto
Document Link], and then click [Properties].

The [Auto Document Link Properties] dialog box appears.

BMake the necessary monitor item settings.
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In-Tray

Follow the procedure below to make settings for an in-tray to be monitored.

In-trays of multiple delivery servers can be set as monitored items.

Limitation

❒ Up to 20 in-trays of all the delivery servers included can be set as monitored
items.

A In the [Auto Document Link Properties] dialog box, click [Add...].

The [Select Server Type] dialog box appears.
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B Click [Delivery Server], and then click [Next>].

The [Delivery Server - Select Server] dialog box appears.

C Click [Browse...] to select a delivery server, or click [Specify...] to enter the de-
livery server name or IP address.

Note

❒ When ScanRouter EX Professional/Enterprise is specified, you may be
asked for a user name, password, and other information.
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D Click [Next>].

The [Delivery Server - Monitor Tray Settings] dialog box appears.

EMake the necessary in-tray and monitor method settings.
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F Click [Next>].

The [Delivery Server - Transfer Settings] dialog box appears.

Note

❒ When the [Transfer new data after notification] check box is not selected in the
[Delivery Server - Monitor Tray Settings] dialog box, the [Finish] button appears
instead of the [Next>] button. Click [Finish] to finish the settings.

GMake the necessary settings for the saving method and file format of image
files.

H Click [Finish].
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Windows Folder

Follow the procedure below to make settings for a local Windows folder or
shared network folder to be monitored.

Limitation

❒ Up to 30 Windows folders, including local folders and shared network fold-
ers, can be set as monitored items.

A In the [Auto Document Link Properties] dialog box, click [Add...].

The [Select Server Type] dialog box appears.

B Click [Windows], and then click [Next>].

The [Windows - Monitor Folder Settings] dialog box appears.

C Select a folder to be monitored, and then make the necessary monitor meth-
od settings.
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D Click [Next>].

The [Windows - Transfer Settings] dialog box appears.

Note

❒ When the [Transfer new data after notification] check box is not selected in the
[Windows - Monitor Folder Settings] dialog box, the [Finish] button appears in-
stead of the [Next>] button. Click [Finish] to finish the settings.

EMake the necessary settings for the saving method and file format of image
files.

F Click [Finish].
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Fax Received File

Follow the procedure below to make settings for Fax Received File to be moni-
tored.

Fax Received Files of multiple network devices can be set as monitored items.

Limitation

❒ Up to 20 Fax Received Files can be set as monitored items.

A In the [Auto Document Link Properties] dialog box, click [Add...].

The [Select Server Type] dialog box appears.

B Click [Fax Received File], and then click [Next>].

The [Fax Received File - Select Device] dialog box appears.

C Click [Browse...] to select a network device, or click [Specify...] to enter the
host name or IP address.
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D Click [Next>].

The [Fax Received File - Monitor Item Settings] dialog box appears.

Note

❒ Depending on the security settings of the selected network device, you
might be required to enter authentication information. Enter the required
information, and then click [OK]. For details about the authentication infor-
mation, consult the administrator of the network device.

❒ Displayed items can differ, according to the security settings of the selected
network device. For details, see Help.

EMake the necessary monitor method settings.
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F Click [Next>].

The [Fax Received File - Transfer Settings] dialog box appears.

Note

❒ An error message appears when the network device does not support Fax
Received File.

❒ When the [Transfer new data after notification] check box is not selected in the
[Fax Received File - Monitor Item Settings] dialog box, the [Finish] button ap-
pears instead of the [Next>] button. Click [Finish] to finish the settings.

GMake the necessary settings for the saving method and file format of image
files.

Important

❒ When the original document is deleted after a transfer is completed, Fax
Received File cannot be checked by other users.

H Click [Finish].

Caplio Digital Camera

Follow the procedure below to make settings for a Caplio digital camera to be
monitored.

Important

❒ To set a Caplio digital camera as a monitored item, you must first switch the
camera on and select either [ORIGINAL] or [MASS STR] for the USB connection
setting. Note the following conditions before making selecting the USB set-
ting:

• [ORIGINAL]
To monitor a Caplio, the driver supplied with the camera must be installed
on your computer.

• [MASS STR]
First refer to the Readme file and check whether your Caplio supports
mass storage connection with Auto Document Link.
Also, check that your computer's operating system is Windows
2000/XP/Vista or Windows Server 2003. 
If the camera or operating system does not support mass storage connec-
tion, select [ORIGINAL].
If you select [MASS STR], the driver does not have to be installed.

A In the [Auto Document Link Properties] dialog box, click [Add...].

The [Select Server Type] dialog box appears.
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B Click [Caplio Digital Camera], and then click [Next>].

The [Caplio - Monitor Settings] dialog box appears.

CMake the necessary monitor method settings.
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D Click [Next>].

The [Caplio - Transfer Settings] dialog box appears.

Note

❒ When the [Transfer new data after notification] check box is not selected in the
[Caplio - Monitor Settings] dialog box, the [Finish] button appears instead of
the [Next>] button. Click [Finish] to finish the settings.

EMake the necessary settings for the saving method.

F Click [Finish].
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Confirmation and Transfer

Automatic Confirmation and Transfer

When you set to monitor in-trays, Windows folders, and Fax Received File, Auto
Document Link automatically monitors the items at each set time. When you set
to monitor a Caplio digital camera, Auto Document Link automatically checks
the file stored inside the camera when the USB cable is connected to the client
computer. When there are documents or files in the monitored items, the follow-
ing are displayed depending on the transfer settings made for each item.

Limitation

❒ For digital camera, files that were transferred before cannot be transferred again.

❒ If your Caplio digital camera does not support mass storage connection with
Auto Document Link, select [ORIGINAL] as the Caplio's USB connection set-
ting. If you select [MASS STR], files cannot be transferred. For details about
whether your Caplio digital camera supports mass storage connection with
Auto Document Link, see the Readme file.

Note

❒ If Auto Document Link is installed under Windows XP, a dialog box for se-
lecting a program appears when you connect the digital camera to the client
computer for the first time. Select [Auto Document Link], select the [Always use
this program for this action] check box, and then click [OK].

Save as Windows File

For in-tray documents and files in Windows folders, the original documents or
files are deleted and saved in the specified Widows folder as files. For Fax Re-
ceived File, deletion of original documents varies depending on the transfer set-
tings of Fax Received File. Files stored in the digital camera are not deleted.

When the arrival of documents or files is set to be notified using a pop-up win-
dow, the [New Data Notification] dialog box appears after the documents or files are
saved in the specified location.

Add as Document

For in-tray documents and files in Windows folders, the original documents or
files are deleted and saved in the specified DeskTopBinder or ScanRouter Doc-
umentServer folder as documents. For Fax Received File, deletion of original
documents varies depending on the transfer settings of Fax Received File. Files
stored in the digital camera are not deleted.

When the arrival of documents or files is set to be notified using a pop-up win-
dow, the [New Data Notification] dialog box appears after the documents or files are
added to the specified location.
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Notification Only

After the arrival of documents or files is confirmed, notification is given via the
selected method. No documents or files are deleted from monitored items.

DeskTopBinder can be started by clicking [Launch DeskTopBinder] in the [New Data
Notification] dialog box. You can use DeskTopBinder to check documents or files
arrived in monitored items.

Important

❒ To check documents or files in monitored items using DeskTopBinder, those
items must be configured as network locations using DeskTopBinder Extend-
ed Features.

Manual Confirmation and Transfer

A Double-click the icon  for Auto Document Link on the taskbar.

If there are no documents or files in the monitored item, the "XXX (the date
when you double-clicked the icon for Auto Document Link) No new data in
all monitored items." message appears. 

When there are documents or files in the monitored item, the following are
displayed depending on the transfer settings made for each item.

Limitation

❒ If your Caplio digital camera does not support mass storage connection
with Auto Document Link, select [ORIGINAL] as the Caplio's USB connec-
tion setting. If you select [MASS STR], files cannot be transferred. For details
about whether your Caplio digital camera supports mass storage connec-
tion with Auto Document Link, see the Readme file.

Note

❒ New data can also be checked from the menu of DeskTopBinder. On the
[Tools] menu of DeskTopBinder, point to [Auto Document Link], and then
click [Check New Data].

❒ When new data in the digital camera is checked, if the new data contains
files that are the same as those already transferred, a confirmation message
about whether or not to transfer them appears.

❒ If Auto Document Link is installed under Windows XP, a dialog box for se-
lecting a program appears when you connect the digital camera to the cli-
ent computer for the first time. Select [Auto Document Link], select the [Always
use this program for this action] check box, and then click [OK].
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Save as Windows File

For in-tray documents and files in Windows folders, the original documents or
files are deleted and saved in the specified Widows folder as files. For Fax Re-
ceived File, deletion of original documents varies depending on the transfer set-
tings of Fax Received File. Files stored in the digital camera are not deleted.

After the documents or files are saved in the specified location, the [New Data No-
tification] dialog box appears.

Add as Document

For in-tray documents and files in Windows folders, original documents or files
are deleted and saved in the specified DeskTopBinder or ScanRouter Document-
Server folder as documents. For Fax Received File, deletion of original docu-
ments varies depending on the transfer settings of Fax Received File. Files stored
in the digital camera are not deleted.

After the documents or files are saved in the specified location, the [New Data No-
tification] dialog box appears.

Notification Only

After the arrival of documents or files is confirmed, notification is given via the
selected method. No documents or files are deleted from monitored items.

DeskTopBinder can be started by clicking [Launch DeskTopBinder] in the [New Data
Notification] dialog box. You can use DeskTopBinder to check documents or files
arrived in monitored items.

Important

❒ To check documents or files in monitored items using DeskTopBinder, those
items must be configured as network locations using DeskTopBinder Extend-
ed Features.
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9. Using SmartDeviceMonitor
for Client

SmartDeviceMonitor for Client Features

SmartDeviceMonitor for Client is available on computers with DeskTopBinder
installed.

SmartDeviceMonitor for Client can monitor printers configured for monitoring,
send notification of printout completion and errors occurring during printing,
and perform Recovery Printing and Parallel Printing.

Also, you can display the [My Job List] window to check the print status of docu-
ments sent from the client computer using the list. Deleting the print job history
and canceling print jobs are possible in the [My Job List] window.

Note

❒ For details about SmartDeviceMonitor for Client, see SmartDeviceMonitor
for Client Help.
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Starting and Quitting

Starting

A Click [Start], and then point to [All Programs] or [Programs].

B Point to [DeskTopBinder], point to [SmartDeviceMonitor for Client], and then click
[SmartDeviceMonitor for Client].

SmartDeviceMonitor for Client starts, and the icon appears on the taskbar.

Quitting

A Right-click the icon on the taskbar, and then click [Exit] on the menu.

SmartDeviceMonitor for Client exits.
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Setting the SmartDeviceMonitor for Client Port

To use Notification and other functions using SmartDeviceMonitor for Client,
set the printer ports to the SmartDeviceMonitor for Client ports.

The SmartDeviceMonitor for Client port supports the following protocols:
TCP/IP, NetBEUI, and IPP.

Important

❒ To make port settings, a printer driver must be installed in the client comput-
er beforehand.

❒ If SmartDeviceMonitor for Client is installed under Windows 2000/XP/Vista
or Windows Server 2003, port settings must be made using an Administrators
group user account.

Limitation

❒ You can use NetBEUI to make port settings for SmartDeviceMonitor for Cli-
ent only if the client is running Windows 2000.

Reference

For details about settings, see SmartDeviceMonitor for Client Help.
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When Selecting TCP/IP or NetBEUI

The following example procedure explains setting SmartDeviceMonitor for Cli-
ent port under Windows 2000. Item names may differ depending on the operat-
ing system.

A Install the printer driver for the printer you want to use.

B Click [Start], and then point to [Settings].

C Click [Printers].

The [Printers] window appears.

D In the [Printers] window, click the icon for the installed printer driver, and
then click [Properties] on the menu that appears when you right-click the
icon.

The printer properties dialog box appears.
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E Click the [Ports] tab, and then click [Add Port...].

The [Printer Ports] dialog box appears.
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F In the [Available port types:] box, click [SmartDeviceMonitor], and then click [New
Port...]. 

The [Add Port] dialog box appears.

G In the [Select Protocol] area of the [Add Port] dialog box, click [TCP/IP] or [Net-
BEUI] for the protocol, and then click [Search].

HWhen [TCP/IP] is selected, click the model of the printer to be used for print-
ing, and then click [OK]. When [NetBEUI] is selected, click the name of the
printer to be used, and then click [OK]. Click [Specify Address] when printing
using a printer that cannot be displayed on the list, or when entering the
port name directly. 

I In the [Printer Ports] dialog box, click [Close].

J In the printer properties dialog box, check the created port name is dis-
played in the [Print to the following port(s)] box and the check box for the port
name is selected, and then click [Close].
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When Selecting IPP

The following example procedure explains setting SmartDeviceMonitor for Cli-
ent port under Windows 2000. Item names may differ depending on the operat-
ing system.

A Install the printer driver for the printer you want to use.

B Click [Start], and then point to [Settings].

C Click [Printers].

The [Printers] window appears.

D In the[Printers] window, click the icon for the installed printer driver, and
then click [Properties] on the menu that appears when you right-click the
icon.

The printer properties dialog box appears.

E Click the [Ports] tab, and then click [Add Port...].

The [Printer Ports] dialog box appears.

F In the [Available port types:] box, click [SmartDeviceMonitor], and then click [New
Port...].

The [Add Port] dialog box appears.
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G In the [Select Protocol] area of the [Add Port] dialog box, click [IPP].

H In the [Printer URL] box in the [Select Printer] area, enter the URL of the re-
quired printer in the following format: 

• http://Printer's IPP server address [: port number]/printer

If the communication is encrypted by SSL, enter the URL in the following for-
mat:

• https://Printer's IPP server address [: port number]/printer

Limitation

❒ SSL communication is available only when using a device that supports
SSL and has the security certificate installed. Also, Internet Explorer 5.01
or later must be installed in the client computer. 

Note

❒ The IP address, host name, or domain name can be used as the printer's IPP
server address.
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Reference

For details about installing certificates on a client computer, see "Setup
Guide" or SmartDeviceMonitor for Client Help.

For details about network device settings necessary for SSL, see the oper-
ating instructions of the device.

I If the IPP user name and IPP password are required for printing, or a proxy
server is being used, click [Detailed Settings], and then make the necessary
settings.

J To specify the name of the port you are adding, enter it in the [IPP Port Name]
box. If you do not enter a port name, the printer’s URL is set as the port
name.

K Click [OK].

L In the [Printer Ports] dialog box, click [Close].

M Check the port name you created appears in the [Print to the following port(s)]
box and its check box is selected, and then click [Close].
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Setting Devices to Be Monitored

Set frequently used printers and network devices as monitored items so you can
easily check on their statuses.

Setting Monitored Printers 

To monitor printer statuses, select the printers you want to monitor in the Win-
dows printer folder, and then specify the address of those printers.

Monitored printers are displayed in the [SmartDeviceMonitor for Client - Status List]
window with their status icons.

A Right-click the icon on the taskbar, point to [Properties], and then click [Mon-
itor Device Settings...].
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The [SmartDeviceMonitor for Client - Options] dialog box appears.

B In [Printer List] on the [Printers Folder] tab, click the name of the printer you
want to monitor. 

Note

❒ In the [Monitoring] column of [Printer List], currently monitored printers are
indicated by "Yes" .

C In [Action:] under [Monitoring Information Settings], select the [To be Monitored]
check box.

Select the [Display on the task bar menu] check box to display the selected printer
on the taskbar menu with an icon.

Select the [Displayed on Task Bar] check box to display its status on the taskbar
icon continuously.
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DWhen using a print server for printing, in the [Address:] box, enter the IP ad-
dress, host name, or IPX address of the printer you want to monitor.

Note

❒ If the IP address has been set in the printer port, the address is automati-
cally imported.

❒ You can read the addresses from the Hosts file by clicking [Import...]. The
IPX addresses for devices on the network can be saved as a Hosts file using
SmartDeviceMonitor for Admin.

E Click [OK].

Adding Network Devices to Be Monitored

Add network devices other than printers, such as copiers, scanners, and fax
MFPs (multifunction peripherals), as monitored items.

Added devices appear in the [SmartDeviceMonitor for Client - Status List] window
with status icons.

The following example procedure explains adding a network device as a moni-
tored item by specifying its address directly.

Reference

For details about how to add a network device as a monitored item by brows-
ing the network, see SmartDeviceMonitor for Client Help.

Adding a device by specifying its address

A Right-click the icon on the taskbar, point to [Properties], and then click [Mon-
itor Device Settings...].

The [SmartDeviceMonitor for Client - Options] dialog box appears.

B Click the [Network Devices] tab, and then click [Add...].

The [Add] dialog box appears.
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C Enter the name, address, and comments of the device you want to add, and
then click [OK]. You can enter the IP address, host name, or IPX address as
the address.

D Check the device name appears in the [Devices to be Monitored] list.

E To display the device on the taskbar menu, click the device in the list, and
then select the [Display on the task bar menu] check box.

F Click [OK].
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Displaying the Device Status

The [SmartDeviceMonitor for Client - Status List] Window

Follow the procedure below to display a list of statuses of the monitored printers
and network devices, and the numbers of print jobs of each printer.

A Right-click the icon on the taskbar, and then click [SmartDeviceMonitor for Cli-
ent - Status List].

The [SmartDeviceMonitor for Client - Status List] window appears.

Note

❒ The printer status icon on the taskbar cannot be displayed while the [Smart-
DeviceMonitor for Client - Status List] window is displayed. The icon reappears
when the [SmartDeviceMonitor for Client - Status List] window closes.

Items displayed in the [SmartDeviceMonitor for Client - Status List ] window

Limitation

❒ No status information is displayed when the printer is connected directly to
the client computer, or if an invalid IP or IPX address has been set for the
printer even though it is connected to the network.

• Name
Name of device and icon that indicates a current status.

• Status
Current status of device.

• Job
The number of print jobs each printer has.

• Type
Type of device.
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Displaying Detailed Device Information

Follow the procedure below to display the [Device Properties] dialog box and the
current status and network settings of a monitored printer or network device.

A Right-click the icon on the taskbar, and then click [SmartDeviceMonitor for Cli-
ent - Status List].

The [SmartDeviceMonitor for Client - Status List] window appears.

B Select the device whose information you want to display, and then double-
click it, or on the [Device] menu, click [Open].

Information about the selected device appears in the [Device Properties] dialog
box.

Note

❒ If a printer or network device is selected for display on the taskbar menu,
you can display its [Device Properties] dialog box simply by clicking the
printer or network device on the taskbar menu.
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Making Notification and 
Recovery/Parallel Printing Settings

SmartDeviceMonitor for Client Extended Features Settings

Extended Features settings are required for various SmartDeviceMonitor for
Client functions. You can configure the following functions in the [Extended Fea-
tures Settings] dialog box:

• [Notification] dialog box display, to receive notification of print completion
and an error occurs during printing

• Recovery Printing, for printing documents using other printers in the printer
group when the specified printer is busy

• Parallel Printing, for equally dividing the number of copies to be printed
among selected printers in the printer group

If the taskbar icon for monitoring print jobs is set for display, you can cancel
printing when this icon is displayed.

Limitation

❒ Recovery Printing and Parallel Printing are available only when printing
from SmartDeviceMonitor for Client port using TCP/IP.

Displaying the [Extended Features Settings] Dialog Box

A Right-click the icon on the taskbar, point to [Properties], and then click [Ex-
tended Features Settings].

The [Extended Features Settings] dialog box appears.

B Select the [Use Extended Features] check box, and then make the required set-
tings for the functions you want to use.

C Click [OK] to close the [Extended Features Settings] dialog box.
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The [Extended Features Settings] Dialog Box

1. Use Extended Features

To use Extended Features, select its check
box.

2. Notification

You can make settings for receiving noti-
fication of print job completion or if an er-
ror occurs during printing.

3. Recovery/Parallel Printing

Recovery Printing and Parallel Printing
settings are available.

4. Monitor print job

You can set to display the taskbar icon for
monitoring print jobs.

ANL019S

1

2

3

4
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10. Backing Up Data

Backing Up Data in Cabinets and Folders

Back up data in DeskTopBinder My Cabinet or removable cabinets to avoid loss
of data due to hardware or software failure.

For backups, start from the [File] menu. 

You can make settings to receive notification of periodic data backup. Backed up
data can also be retrieved.

• Manual backup
Select the folder you want to back up. On the [File] menu, click [Back up...].
In the [Back Up] window, select the objects you want to back up.
In the [Save As] window, specify the name for the backup file and the location
where you want to save the file.

• Periodic backup
To back up data periodically, on the [Backup] tab in the [My Cabinet Properties]
or [Removable Cabinet Properties] dialog box, make the necessary backup set-
tings.

• Extract backup data
Use Windows Explorer and uncompress the file.
In the [Extract To] dialog box, click [Browse DeskTopBinder Tree]. Specify the lo-
cation for the file and uncompress.

Reference

For more information about backups, see DeskTopBinder Help.
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11. Appendix

Other Function and Tool Available from 
Client Computers

Printer Driver Preview and Print Function

The Preview and Print function is available on client computers that have Desk-
TopBinder installed. When printing a document using a printer driver, you can
use this function to display a preview of the document without having to start
DeskTopBinder.

Limitation

❒ This function might be unavailable, depending on the printer model and
printer driver version.

Reference

For more information about network devices that support the Preview and
Print function, see the Compatible Device List.

Import & Convert Tool

Import & Convert Tool is also available on client computers that have DeskTop-
Binder installed.

Import & Convert Tool enables you to collectively add files in Windows folders
to DeskTopBinder My Cabinet.

These files can then be converted to image or PDF files.

Note

❒ If files cannot be converted to PDF, check if Convert to PDF is configured
from Extended Features.

Reference

For details about Import & Convert Tool operations, see DeskTopBinder
Help.
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Registrable Numbers in DeskTopBinder

The recommended numbers of folders, documents, sections, shared cabinets,
and removable cabinets that DeskTopBinder can manage are as follows:

• Folders:
200 or less recommended per cabinet
50 or less recommended per folder

• Documents
1000 or less recommended per cabinet
100 or less recommended per folder

• Sections
1000 or less recommended per cabinet
100 or less recommended per folder
100 or less recommended per document

• Shared cabinets and removable cabinets
Up to total of 49
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File Types

Files Created Using Applications

DeskTopBinder can manage files with the extensions below.

When these files are used with DeskTopBinder, the respective applications must
be installed.

• .txt
WordPad or another text editor must be installed.

• .doc (a file created using Microsoft® Word 97/98/2000, Microsoft® Word ver-
sion 2002, Microsoft® Office Word 2003/2007)
Microsoft® Word 98/2000, Microsoft® Word version 2002, or Microsoft® Of-
fice Word 2003/2007 must be installed.

• .rtf (a file created using Microsoft® Word 97/98/2000, Microsoft® Word ver-
sion 2002, or Microsoft® Office Word 2003/2007)
Microsoft® Word 98/2000, Microsoft® Word version 2002, or Microsoft® Of-
fice Word 2003/2007 must be installed.

• .docx, .docm (a file created using Microsoft® Office Word 2007)
Microsoft® Office Word 2007 must be installed.

• .ppt (a file created using Microsoft® PowerPoint® 97/2000, Microsoft® Pow-
erPoint® version 2002, or Microsoft® Office PowerPoint® 2003/2007)
Microsoft® PowerPoint® 2000, Microsoft® PowerPoint® version 2002, or Mi-
crosoft® Office PowerPoint® 2003/2007 must be installed.

• .pptx, .pptm (a file created using Microsoft® Office PowerPoint® 2007)
Microsoft® Office PowerPoint® 2007 must be installed.

• .xls (a file created using Microsoft® Excel® 97/2000, Microsoft® Excel® version
2002, or Microsoft® Excel® 2003/2007)
Microsoft® Excel® 2000, Microsoft® Excel® version 2002, or Microsoft® Office
Excel® 2003/2007 must be installed.

• .xlsx, .xlsm (a file created using Microsoft® Office Excel® 2007)
Microsoft® Office Excel® 2007 must be installed.

• .pdf (a PDF version 1.2/1.3/1.4/1.5/1.6 file created using Adobe® Acrobat®

3.0/4.0/5.0/6.0/7.0/8.0)
Adobe® Acrobat® 5.0 or later must be installed.



Appendix

134

11

Limitation

❒ For files with a format not supported by DeskTopBinder, operations from
DeskTopBinder may not be performed properly.

❒ The following functions cannot be used for Microsoft® Office 2007 files that
were added as document management server or delivery server documents
and have a ".docx", ".docm", ".pptx", ".pptm", ".xlsx", or ".xlsm" extension:

• Printing from servers

• Faxing from servers

• Creating Content Text Search data

• Creating PDF data

• Creating Web Viewer Display data

Image Files

Scanned documents and the following image files are displayed as thumbnails
in the document list pane and the section list pane of Viewer. Exif information
(such as shooting date) of Exif-compliant files is set to document properties
when they are added. You can display Exif information using Properties. All
digital cameras have a shoot date recording function; however, camera memo
recording is unique to the Caplio digital camera.

Only files listed below are treated as image files.

• BMP (Uncompressed)
Black & White (1 bit), 256 colors (8 bits), Grayscale (8 bits), Full Colors (24 bits)

• TIFF compliant to multi-pages (Uncompressed, Packbits)
Black & White (1 bit), 256 colors (8 bits), Grayscale (8 bits), Full Colors (24 bits)

• TIFF compliant to multi-pages (ITU-T G3 FaxMH, ITU-T G3 FaxMR, ITU-T
G4 FaxMMR, TIFF-MH (Huffman RLE))
Black & White (1 bit)

• TIFF compliant to multi-pages (JPEG (JFIF) -YCbCr)
Grayscale (8 bits), Full Colors (24 bits)

• TIFF Class F compliant to multi-pages (ITU-T G3 FaxMH, ITU-T G3 FaxMR,
ITU-T G4 FaxMMR)
Black & White (1 bit)

• JPEG (Normal, Progressive)
Grayscale (8 bits), Full Colors (24 bits)

• PNG
Black & White (1 bit), 256 colors (8 bits), Grayscale (8 bits), Full Colors (24 bits)

Note

❒ To use functions that require devices, those devices must support the file
types mentioned above.
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Some illustrations or explanations in this guide may differ from your product due to improvements or

changes in the product.

Notes:

1. The contents of this documents are subject to change without notice.

2. No part of this document may be duplicated, reproduced in any form, modified or quoted without

prior consent of the supplier.

3. THE SUPPLIER SHALL NOT BE LIABLE FOR THE RESULT OF THE OPERATION OF THIS

SOFTWARE OR THE USE OF THIS DOCUMENT.

Important
❒ It is possible that any document or data stored in the PC will be damaged or lost by user error during

operation or software error. Be sure to back up of all important data beforehand. Important docu-

ments and data should always be copied or backed up. Documents and data can be lost because

of malfunction or human error. Furthermore, the customer is responsible for protection measures

against computer viruses, worms, and other harmful software.

❒ Do not remove or insert any disk while operating this software.

❒ THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR DAMAGES OR LOSS OF ANY DOCU-

MENT OR DATA PRODUCED BY USING THIS SOFTWARE.

❒ THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL

OR INDIRECT DAMAGES (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF

PROFITS, BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION, AND THE

LIKE) CAUSED BY FAILURE OF THIS SOFTWARE OR LOSS OF DOCUMENTS OR DATA, NOR

FOR ANY OTHER DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, IF THE SUP-

PLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Copyright © 2005-2008
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